
Interoperability Guide



Interoperability Revit AutoCAD   I   2

Autodesk® Revit® is a complete 
architectural design and 
documentation solution, 
supporting all phases of design 
and all architectural drawings 
and schedules required for a 
building project. From massing 
and conceptual studies through 
the most detailed construction 
drawings and schedules, Revit 
has tools to help you deliver 
productivity, coordination, and 
quality to the building team.

Revit can be used alone or in 
conjunction with AutoCAD® 
software. This guide will help 
those who are familiar with  
AutoCAD better understand 
how Revit works, intro ducing 
some of the main features and 
concepts of Revit and comparing 
them with similar features of 
AutoCAD.

This guide also demonstrates 
how you can use Autodesk  
Revit with AutoCAD to help 
manage a project and its  
deliverables. You‘ll learn how to 
integrate existing AutoCAD  

projects with Revit to produce 
construction documents. 
The process relies on the 
export compatibility of Revit 
and the external referencing 
capabilities of AutoCAD. 

Revit provides DWGTM 
compatibility using the  
Autodesk® ObjectDBX™ 
toolkit, and works with 
AutoCAD to help provide clear 
communication of design data 
among project teams.



Interoperability Revit AutoCAD   I   3

Content

1  Using Revit with AutoCAD 

2  Preparing for Data Export

3  Drafting in AutoCAD

4  Referencing Data into Revit 

5  Step by Step: Exporting to AutoCAD and Relinking to Revit

6  Step by Step: Linking DWG Details to Revit 



Interoperability Revit AutoCAD   I   4

Using Revit with AutoCAD

Here are the basic steps for using an Revit 
project with AutoCAD:

1    Create the building model in Revit.

2    Set up sheets for the project in Revit.

3      Export selected views or sheets to DXFTM/
DWG* format for AutoCAD users.

4      Annotate the exported DXF/DWG files in  
AutoCAD by referencing the files.

5      Link any data created externally into Revit 
as external reference files to help keep 
data consistent.

Here is a workflow summary of tasks you‘ll 
perform as you work through a project using 
Revit and AutoCAD:

At Project Startup
 ■ Set up the project in Revit.
 ■ Create any necessary building scale views.
 ■ Define appropriate worksets.
 ■ Begin modeling the building.
 ■ Set up preliminary sheets in Revit.

During Design Phases
 ■ Create any necessary enlarged scale views.

 ■ Continue modeling the building.

 ■ Create a “cartoon set“ of sheets in Revit.

 ■ Set up folders for linked files to be 
exported to AutoCAD.

At Start of Construction Documents
 ■ Create any necessary detail views.

 ■ Begin detailing the building.

 ■ Determine what details to reuse from an 
existing library.

 ■ Revise the cartoon set of sheets to include 
any additional sheets.

 ■ Create a list of sheets to be worked on in  
AutoCAD.

 ■ Export this list of sheets.

 ■ Link any AutoCAD data into the appropriate  
Revit views.

At Conclusion of Construction 
Documents

 ■ Archive the files created.

1

* DWG is the native file format for Autodesk’s AutoCAD® software and is a trademark of Autodesk, Inc.
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When preparing to export an Revit model, you 
need to consider export methods, file naming 
conventions, data export options, and layering 
standards.

Exporting Views or Sheets
You can export either views or sheets, 
depending on the scope of work to be done 
in AutoCAD, as well as the progress of 
construction documentation in Revit.

Exporting a view creates a DWG or DXF file of 
the currently selected Revit view. All external 

data linked to the view will be embedded as a 
block in DWG or DXF format. Use this method 
when you intend to annotate only selected 
views in AutoCAD.

Exporting an entire sheet from Revit produces 
a set of DWG or DXF files. One file contains 
sheet information (borders, title block) with a 
viewport for each view. 

Each Revit view becomes an individual file 
referenced into the sheet file and displayed in 
the appropriate viewport. All files are located 
in the same directory to facilitate tracking and 
management.  
 

Naming Conventions
To help keep file names consistent throughout 
the project, use the Revit default naming  
convention, as shown here:

Exported Sheets
[Project Filename]-[View Category]-[Sheet 
Number]- [Sheet Name].[Extension]
 
Exported Views (on sheets)
[Project Filename]-[Extension]-[View 
Category]-[Sheet Number]-[Sheet Name]--
[View Identifier].[Extension]

 ■ Project Filename: Name of the Revit file
 ■ Extension: Standard Revit file extension 

(rvt, rft, rfa), depending on the file open in 
Revit

 ■ View Category: Floor Plan, 3D View, 
Elevation,  
Section, Drafting View, or Drawing Sheet

 ■ Sheet Number: Standard sheet number
 ■ Sheet Name: Standard sheet name
 ■ View Identifier: Standard view name
 ■ Extension: Exported DWG or DXF, 

depending on user selection

Preparing for Data Export2
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Preparing for Data Export

Data Export Options 
The following options are available in the Export dialog box:

Export Range: Select either the current view or a set of views/sheets.  
The latter facilitates a batch-like export of a range of views.

Export Layers File: The file displayed by default is the current export 
layer standard. You can select a different export standard if you wish.

Layering Standards
In the Export Layers dialog box, categories and subcategories of Revit 
host components are mapped to a layer name and color number for use 
in a DWG or DXF file, using settings specified in special text files in the 
Revit\Data directory. 

By default, Revit uses the last-specified export layer standard. The 
software supplies files for the AIA, BS1192, ISO 13567, and CP 83 
standards. You can select from these or create custom standards.

You can incorporate custom office-dependent layering standards into 
the workflow and apply them to external files. This helps support data 
consistency within a multi-platform environment.
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The following techniques can facilitate a 
smooth workflow in a multi-platform project 
environment.

Linking Files
Rather than drafting directly in DWG or 
DXF files exported from Revit, you should 
use the AutoCAD external reference (xref) 
functionality. Open an empty drawing in 
AutoCAD and, using the Xref Manager, attach 
the exported Revit view as an Overlay for 
Reference Type.

 

Referencing Views  
and External Data
Because Revit does not require the use of 
coordinates, the guidelines given here enable 
precise alignment between externally created 
data and the building model. These methods 
help prevent offsets from occurring when 
exported DWG or DXF data is referenced into 
AutoCAD, as well as when externally created 
data is re-imported into Revit.

In AutoCAD, use 0,0,0 as the insertion point 
when using xrefs. Do not change the insertion 
point to Specify On-screen. Specifying a 
user coordinate system or using wblocks can 
introduce new origins and offsets when re-
importing AutoCAD data into Revit.

Try to maintain a form of visual proof or a 
reference point for externally created data. 
Building features often give the best visual 
feedback to help enable precise alignment. 
You might also locate points or other reference 
marks at grid intersections.

Externally created data can be aligned 
precisely using the Revit snapping, alignment, 
and locking functions.

Naming Drawings
Using the default Revit naming convention is 
highly recommended. For more information, 
see “Naming Conventions” on page 5.

If new drawings created outside Revit use 
data exported from Revit as the external 
reference, appropriate file names are required. 
Use the name of the existing DWG or DXF file 
and add a prefix or suffix to create the new file 
name.

For example, a drawing might use the 
following file as an external reference:
Hotel ProdEx-MT Copy-rvt-Floor Plan-Level 
16-Mechanical.dwg

When the drawing is re-imported into the 
Revit view ‚Level 16 - Mechanical,‘ it could 
have this name:
Hotel ProdEx-MT Copy-rvt-Floor Plan-Level 
16-Mechanical-ANNO.dwg

Drafting in AutoCAD3
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Finally, data created in the external system is  
referenced into Revit to help provide 
consistency throughout the design and 
documentation phases.

 
Preparing for Referencing
In AutoCAD, unload the external references 
that were exported from Revit to minimize 
redundant display of information (unless such 
display is desired for temporary referencing 
purposes).

 

File Linking Options
On the Revit File menu, go to the Insert Tab 
and select Import CAD to bring in external 
data.

The Import/Link dialog box in Revit offers 
options for linking a document created 
externally.

Referencing Data into Revit4
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Referencing Data into Revit

Import or Link
You can reference DWG or DXF data created in  
AutoCAD into the current Revit project.

 ■ Link (instead of import): Select Link if you 
want data to automatically update when 
the external file is changed. 

 ■Current view only: Select Current view only 
to ensure linked files are visible only in 
the current view. It also ensures correct 
display of  
annotations and dimensions.

Scaling
In most cases, use Auto-Detect to help 
generate correct scaling of linked data.

Layer/Level Colors
These three options control the appearance of 
the file linked into Revit.

 ■Black and White: Ignores color information 
in the external file and displays linked data 
as black and white vectors. 
 
 
 

 ■Preserve Colors: Preserves the layer or 
level color settings in the external file.

 
 
 
 

 ■ Invert Colors: Inverts the colors in the 
linked file, making them easier to see. If 
you use a black background in AutoCAD, 
colors may not be appropriate on a white 
background in Revit.
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Referencing Data into Revit

Positioning
If you followed the guidelines in “Referencing Views and External 
Data” on page 8, correct alignment is best supported by selecting 
Automatically place in the Import/Link dialog box. 

Automatically place: Select one of these options for automatic 
placement:
 

 ■   Auto - Center-to-center: Aligns the center of the linked or imported 
file to the center of the Revit view. Use this option when external 
data is offset from the origin of the drawing. 

 ■   Auto - Origin to Internal Origin: Aligns the origin of the imported 
or linked file to the origin of the Revit view. Use this option when 
relinking DWG files originally created in Revit. 

 ■   Auto - By Shared Coordinates (for linked files only): Acquires origin 
for use with Revit files. Use this option when linking multiple 
buildings together that need to maintain a relationship to each 
other, or when linking a number of building files together with a site 
plan.

 
 
 
 
 
 
 
Manually place: If offsets and dislocations were introduced during the 
process, or if you want to link a detail into a drafting view, these options 
help position the data that is externally linked:

 ■   Manual - Origin: The linked or imported file appears attached to the 
Revit cursor at its origin. This is the typical option to manually place 
data. 

 ■   Manual - Center:  The linked or imported file appears attached to 
the Revit cursor at its geometric center point. This option is helpful 
when handling widely displaced data. 

 ■   Place at: The origin point of the linked or imported file is placed at 
this level in the host Revit model. 

 ■   Orient to View: When True North and Project North are not aligned 
in the host Revit model, use this option to orient the CAD file in the 
view.
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Referencing Data into Revit

Controlling the appearance  
of Linked Data
The appearance of imported or linked data is  
managed using the Imported Objects tab in 
the Object Styles dialog box. Go to the Manage 
Tab and select Object Styles. You can control 
the line weight, line color, line pattern, and the 
material for each layer or level in the linked 
file.
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Referencing Data into Revit

Specifying Line Weights in Linked  
or Imported Drawings

You can specify line weights in imported files. Click on the Insert Tab 
and select Import Lineweights. This dialog box coordinates color 
mapping in linked files to Revit line weights. The mapping can be saved 
to or loaded from an external text file. 

 
You can review Revit line weight settings going to the Manage tab and  
selecting Lineweights from the Additional Settings Dropdown on the 
Settings Panel. Because Revit line weights have different widths at 
different scales, many imported colors may map to a single line weight
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Referencing Data into Revit

Controlling the Visibility of Entities  
in Linked Files
You control visibility of entities in imported 
files in the Visibility/Graphic Overrides dialog 
box. On the Imported Categories tab, you can 
specify visibility by layer for entire imported 
files or for all imports as a whole.
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This graphic illustrates the process of exporting a view from Revit 
into an empty DWG file. After you edit the file in AutoCAD, you link 
it back into the Revit project.

Using a floor plan view as an example, the following steps show 
you how to use AutoCAD to annotate building model data created 
in Revit.

Step by Step:  
Exporting to AutoCAD and Relinking to Revit

Revit

AutoCAD

Revit DWG

New DWG

5
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Step by Step: Exporting to AutoCAD and Relinking to Revit

 Step 1     Export the Data
 
In Revit, you can export either single views 
or entire sheets. When exporting entire 
sheets, you export the files into different 
subdirectories, giving each directory the 
same name as the sheet itself to help provide 
consistent naming throughout the project.

Revit button > Export > CAD Formats - DWG
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Step by Step: Exporting to AutoCAD and Relinking to Revit

 Step 2      Draft and  
annotate in   
AutoCAD

For each Revit view to be annotated 
in AutoCAD, open a new DWG file 
using either a template file or Start 
from Scratch.

Use Attach in the Xref Manager to 
externally reference the exported 
views created in Step 1.
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Step by Step: Exporting to AutoCAD and Relinking to Revit

Be sure to use 0,0,0, not Specify On-screen, as the insertion 
point in AutoCAD. Select Overlay for Reference Type. (Unlike 
Attachment, an overlaid xref is not included when the host 
drawing is itself attached or overlaid as an xref in another 
drawing.)

 
You can now begin drafting and annotating in AutoCAD.
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Step by Step: Exporting to AutoCAD and Relinking to Revit

 Step 3     Save the drawing
Save the drawing in the same directory as the 
linked DWG file. Create the file name by adding 
a suffix to the name of the linked file. For 
example, when the linked DWG name is

Floor Plan-Level 1.dwg,

the annotated DWG file should be

Floor Plan-Level 1-ANNO.dwg.
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Step by Step: Exporting to AutoCAD and Relinking to Revit

 Step 4    Link the Edited DWG 
File into Revit

There are two ways to link edited DWG files. 
You can link the newly created DWG file with or 
without the underlying AutoCAD xref attached. 
Both methods are discussed here.

 
Linking the File with the Underlying Xref 
Attached
This method allows that the data created 
in the DWG file to be precisely inserted into 
Revit, because the originally exported file is 
still visible. This method is recommended for 
concurrent use of AutoCAD and Revit while 
annotating views in Revit is still underway.

On the Insert Tab, click Link CAD and select the 
newly created DWG file in the Import/Link dialog 
box. Select the Link (instead of import) and the 
Current view only options. Under Positioning, 
select Automatically Place, and then select 
Origin to origin.
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Step by Step: Exporting to AutoCAD and Relinking to Revit

After the file is linked, suppress display of the Revit-generated 
elements. In AutoCAD, unload the Revit exported file. Return to Revit 
and click Manage Links from the File menu. Select the linked file, and 
click Reload.

As an alternative, you can turn off layers that were generated by the 
original export on the DWG/DXF/DGN Categories tab in the Visibility/
Graphics Override dialog box. Either method removes display of 
redundant entities.

Linking the File Without the Underlying Xref
Use this method if you do not need to see the original Revit-derived 
data in the AutoCAD xref. After you annotate the DWG file, you unload 
the xref , and then save the file before linking it back into Revit. In 
AutoCAD, you now see only the annotation that you created.

When you link the file in Revit, the annotation you added externally 
displays without the redundant display of AutoCAD entitities.

If you need to reference the Revit data in AutoCAD in the future, reload 
the xref in Xref Manager and save the file. It remains visible in AutoCAD, 
but is not visible when the edited DWG is linked into Revit.
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Step by Step:  
Linking DWG Details to Revit

The steps in this section show you how to link  
existing DWG details to an Revit project. 

 Step 1   Create Drafting Views  
  for the DWG Files
For each detail you want to import or link, 
create and name new drafting views in Revit, 
as shown here.

6
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Step by Step: Linking DWG Details to Revit

 Step 2 Import or Link the   
 DWG Files
After the drafting view has been created, you 
either import or link the external file. Open the 
new drafting view, and Click on Import CAD 
from the Insert Tab. Select the Preserve colors 
and the Centerto-center options for the best 
performance.

If you import the file, the data is embedded 
in the Revit project. If you link the files, the 
result is a smaller Revit file that can be further 
modified in AutoCAD. Revit automatically 
gets the most current version of the linked 
file whenever the project is opened or the 
link is reloaded. It is best to use Link if you 
plan to develop details in AutoCAD. Import 
is recommended if you plan to modify your 
details using Revit.
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Step by Step: Linking DWG Details to Revit

 Step 3  Place the Details on a Sheet
After arranging the individual detail files in drafting views, open an 
existing sheet or create a new sheet for the details. Go to the View Tab 
and select New Sheet from the Sheet Composition panel. Then select 
the appropriate titleblock.

After you have created the sheet, place the drafting views. Place 
drafting views in the same way you would place any view created in 
Revit. 



Interoperability Revit AutoCAD   I   24

Step by Step: Linking DWG Details to Revit

Place drafting views in the same way you 
would place any view created in Revit. After 
you have placed the view, the DWG details are 
part of your Revit set.
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Features of Revit
  True 3D Design

Using Revit, you work with architectural models 
rather than geometry. With Revit, you can 
switch among views and schedules as you like. 
Because you create a parametric building model, 
dependencies are automatically updated as you 
make changes.

  Parametric Objects

Revit contains 3D parametric building elements, 
which carry information about their relationships 
to other objects in the building, in contrast 
with the blocks and solids used in AutoCAD. For 
example, in Revit, the properties of a wall can 
state that it should rise to the next level or roof. 
After you specify this property, the wall retains its 
relationship to the next level or roof regardless of 
other changes you may make in the building.

Dimensions correspond to the actual size of 
building elements. Updating a dimension updates 
the parametric components and their relationships 
to other components. Locking a dimension allows 
you to embed your  design intent. After a dimension 
is locked, the dimensioned relationship is 
maintained. Dimensions in schedules behave in the 
same way: if you change width and height values 

in a schedule, the revised size is reflected in the 
elements of the model. Coordination of dimensions 
and graphics is maintained throughout the Revit 
model.  

  Families vs. Blocks

AutoCAD users are accustomed to storing symbols 
in individual DWG files. With Revit, you store similar 
parametric components in family files. Family files 
can contain many styles of components, providing 
easier organization and data sharing, and offer 
numerous placement options. You can customize 
family files; for example, you can modify alignment 
planes or add subcategories to objects. You can 
also create intelligent parametric objects or 
customize the ones included with Revit.

  Alignment vs. Osnaps

Revit offers sketching tools such as temporary 
dimensions and alignment guides. Alignment 
guides are similar to the object snap features 
in AutoCAD. Temporary line and arc extensions, 
and snap points relative to your current position, 
aid you as you design. With Revit, you can place 
components and modify the design later. Doors 
open in the desired direction and windows are 

placed at the correct height on the wall. You can 
place components in either two-dimensional (2D) 
or three-dimensional (3D) views.

  Multiple Design Views

With Revit you can work with components in any 
view, including schedules. Multiple views can 
be open at the same time, and changes made in 
one view are immediately updated in the others, 
making Revit a valuable tool for experimenting with 
design changes. You can open plan and 3D views 
side by side to help you verify whether modifying a 
component on one level interferes with any design 
intent on another level.

  No Command Line or Layers

AutoCAD users will notice the absence of a 
command line and the layer control feature. In 
Revit, building tools and components are presented 
on a Ribbon. Visibility of components is controlled 
through the Visibility/Graphic Overrides feature, 
which works on a per-view basis (comparable  
to the AutoCAD Freeze/Thaw by viewport  
feature). Color and linetype are also  
controlled by category. The  
display of components  
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Features of Revit
depends on the view in which they are seen. For 
example, components display only a footprint in 
plan view, while displaying all geometry in a 3D 
isometric view.

  Single File, Multi-User Projects

In Revit, project data is stored in a single file, 
reducing the need to work with external blocks 
and xrefs. Architects work in teams, with each 
assigned a specific functional area. This involves 
simultaneously working on and saving different 
portions of the project. Revit projects can be 
subdivided into worksets. A workset is a collection 
of elements in the building that can be edited by 
one architect at a time.

  Parametric Relationships

By using the dimensioning and alignment 
locking features in Revit, you can place building 
components in relation to others and keep them 
that way throughout the design. You can lock 
components together in more than one place to 
preserve wall alignments, room areas, or door and 
window placements, even as the model is being 
altered in other areas. Component relationships 
may be constrained or overridden at your 
discretion. Dimensions may be locked or editable 
while the parent objects behave accordingly. 

Because objects can be aligned and locked into 
place, repetitive editing commands are reduced, 
allowing for faster work and fewer errors.

  Read/Write DWG

Revit provides DWG compatibility using the 
Autodesk ObjectDBXTM toolkit. You can import and 
export models to DXFTM and DWG formats. When 
exporting, Revit matches its components and their 
subcategories from the current view to AIA or user-
defined layer names. You can also import these 
formats into 2D or 3D views, allowing for smoother 
coordination and exchange of information among 
team members.

  Producing Paper Drawings

All drawings are produced from the single 
parametric building model used to create the 
design. Any changes to the design are updated in 
the drawing sheet views. Changes to elevations, 
sections, and callouts are immediately updated in 
all reflected views. Any view that you create  
can be added to a sheet and scaled.  
 
 

After you place the drawing on a sheet, you can  
perform last-minute placements just as easily in 
a sheet view as in a model view. Scale-dependent 
line weight and scale-independent annotation size 
allow you to reuse information in views without 
complex reformatting. 

The WYSIWYG display lets you see the final result  
before output, helping to reduce plotting errors.  
Plotter hardware support in Revit is limited only by  
the operating system. Revit can use any Microsoft®  
Windows® driver available for your plotter.
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